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Software Server License Agreement 
This AccuSoft software product ("Product") is a proprietary and copyrighted Product of 
Schellenbach & Associates, Inc. dba AccuSoft Enterprises ("ASE"). It is licensed (not sold) to you, 
and you may use this Product only on the terms of this license from ASE, even though you may 
have obtained the Product from a dealer or other source. 

 
License 
ASE grants you a non-exclusive license only to: 

1. use the Product on one or more computers you own or use at a single location or facility, 
solely for use by persons within that location or facility. You may make copies of this Product 
as necessary to use the Product with other Computers at your licensed location or facility. A 
separate license is required for each location or facility at which the Product is used. 

2. post AccuTerm Session files (.ats) you create using the Product on a single Internet or 
intranet server (the licensed server). Any and all AccuTerm Session files must be posted to 
the same licensed server. If you change servers, you must remove all AccuTerm Session 
files from the old server. A separate license is  required for each server that AccuTerm 
Session files are posted to. 

3. make one copy of the Product for archival or backup purposes in support of your use of the 
Product. 

4. transfer the Product and this license to another party if the other party agrees to accept the 
terms and conditions of this Agreement. If you transfer the Product, you must at the same 
time either transfer or destroy all copies, including any portions of the product merged into 
other programs or stored on computer memory devices such as hard disks. IF YOU 
TRANSFER POSSESSION OF ANY COPY OR MERGED PORTION OF THE PRODUCT 
TO ANOTHER PARTY WITHOUT TRANSFERRING THE PRODUCT ITSELF AS 
PROVIDED HERE, YOUR LICENSE IS AUTOMATICALLY TERMINATED. 

Except as otherwise provided in this agreement, you have no right under this license to rent, lease, 
transfer, or distribute the Product. You may use the Product in object code form only. 

 
Title 
Title and copyright to the Product, including the Product media and documentation, remain with 
ASE. You are not the owner of this Product, but you have the right to use it in accordance with this 
license. You are not licensed to copy, reproduce or make data transmissions, in whole or in part, of 
the Product, except as is permitted in this license. You agree not to modify, reverse engineer, 
translate, disassemble or decompile the Product, in whole or in part. 

 
License Term 
The license is effective upon opening of the Product package or use of the Product and shall 
continue until terminated. You may terminate it at any time by destroying the Product together with 
all copies and the Product Documentation. THIS LICENSE WILL TERMINATE AUTOMATICALLY 
IF YOU FAIL TO COMPLY WITH ANY TERM OR CONDITION OF THIS LICENSE. Upon 
termination you agree to destroy the Product, the Product Documentation and all copies, purge the 
Product from all computers and memory devices such as hard disks, and eliminate the Product 
from any merged programs. 

 
Limited Warranty 
ASE warrants that for a period of six(6) months from date of purchase the Product will perform 
according to the specifications set forth in the associated Product Documentation and the diskette 
(or other medium) on which the Product is located will be free from defects in materials and 
workmanship under normal use. 

YOU ASSUME THE RESPONSIBILITY FOR THE SELECTION OF THE PRODUCT TO ACHIEVE 
YOUR INTENDED RESULTS, AND FOR THE INSTALLATION, USE AND RESULTS OBTAINED 
FROM THE PRODUCT. ASE does not warrant that the functions contained in the Product will meet 
your requirements or that the operations of the Product will be uninterrupted or error free, or will 
function properly in every hardware environment. This warranty gives you specific legal rights and 
you may also have other rights which vary from state to state. 



 

   

EXCEPT AS EXPRESSED HEREIN, THE LICENSED PROGRAM IS PROVIDED TO YOU "AS IS". 
ASE DISCLAIMS TO THE FULLEST EXTENT PERMITTED BY LAW ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WHICH SHALL IN NO 
EVENT EXCEED ONE YEAR. Some states do not allow the exclusion of implied warranties so the 
above exclusion may not apply to you. 

No person is authorized to modify the warranties contained in this license or make any different 
warranty for the Product. 

 
Limitations of Remedies 
ASE's entire liability and your exclusive remedy shall be limited to: 

1. the replacement of any Product, including its diskette or other medium, that does not meet the 
standards of the limited warranty above. To use this warranty, you must return, at your 
expense, the Product and all copies along with a copy of your purchase invoice and a brief 
description of the defect to AccuSoft Enterprises, Customer Service Dept., 8041 Foothill 
Blvd., Sunland, CA 91040. Upon verification of the defect, ASE will send to you, at ASE's 
expense, a replacement Product.  

2. If ASE is unable to deliver a replacement which is free of defects, ASE will refund your 
purchase price. 

IN NO EVENT WILL ASE BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST 
PROFITS, LOST SAVINGS, LOST DATA OR OTHER INCIDENTAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PRODUCT EVEN IF ASE 
OR ANY OF ITS DEALERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, 
OR FOR ANY CLAIM BY ANY OTHER PARTY. ASE'S MAXIMUM LIABILITY SHALL IN NO EVENT 
EXCEED THE PURCHASE PRICE YOU PAID FOR THE PRODUCT. Some states do not allow the 
limitation or exclusion of liability for incidental or consequential damages so the above limitation or 
exclusion may not apply to you. 

 
Customer Registration 
ASE may from time to time revise and update its Product or provide useful customer information. 
You may wish to know about Product improvements and the availability of upgrades. To obtain this 
useful service, you must fill out and return the enclosed customer registration card. ASE urges you 
to do so immediately. 

 
General 
You may not sublicense, assign or transfer this license or the Product to any other person or entity 
except as expressly allowed in this license. Any attempt to sublicense, assign or transfer is void.  

This Agreement will be governed by laws of the State of California, exclusive of its choice of law 
provisions. 

You further agree that this is the complete and exclusive statement of the agreement between us 
which supersedes any proposal or prior agreement, oral or written, and any other communications 
between us relating to the subject matter of this agreement. 

If any provision of this agreement shall be held to be invalid, illegal or unenforceable, the remaining 
provisions shall not be affected. 

If you have any questions concerning this license, you should contact AccuSoft Enterprises,  
Customer Service Dept., 8041 Foothill Blvd., Sunland, CA 91040. 
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INTRODUCTION 
 
 
Welcome to AccuTerm 2000 Internet Edition – the fastest way to deploy 
legacy applications on the Web! 
 
 

Features of AccuTerm 2000 Internet Edition 
 
 
Users can access legacy applications using Internet Explorer. The 
terminal emulator automatically downloads and installs and runs inside an 
Internet Explorer window. 
 
No need to learn another application. The user only needs to know how 
to use Internet Explorer to navigate to your web site. 
 
No charge for client license. You can allow an unlimited number of users 
to access your site with no per-client charges. 
 
Telnet and Secure Shell connections for greatest flexibility and security. 
 
Super accurate emulations. When you use AccuTerm everything will 
work just like the terminal being emulated.  No strange problems with 
word processors or spreadsheets.  No messed up screens.  No hassles. 
 
File transfer capabilities using industry standard protocols like Xmodem, 
Ymodem, Zmodem, and Kermit. MultiValue file transfer utilities include 
text and data files and direct Pick-to-Pick file transfer. 
 
Scripting language allows users to write scripts and macros using Visual 
Basic for Applications. 
 
Integrated scroll back with automatic scrollbar and mouse wheel support. 
 
Extended screen support of up to 160 columns by 60 rows. 
 
Automatic font scaling so that you can always see the full screen.  This is 
a great feature that once you get used to it, you'll never want to go without. 
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Hardware and Software Requirements 
 
Memory: 32MB 
 
Processor: Pentium 120 or better 
 
Windows: 95, 98, ME, NT 4.0, 2000 
 
Internet Explorer: 3.0 or above (4.0 or above recommended) 
 NOTE: Netscape browsers are not supported. 
 
Host Connection: permanent TCP/IP connection with public IP address 

for Internet access 
 
User Connection: any TCP/IP connection to the Internet 
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GETTING STARTED 
 
 
This manual assumes that you have a working knowledge of the Windows 
environment, Internet, Internet Explorer and your host application’s 
terminal requirements. 
 
 
 

Installation 
 
 
To install AccuTerm 2000 Internet Edition, insert the AccuTerm 2000 
Internet Edition program CD and follow the prompts.  
 

1) Start the setup program: 
 
Insert the CD. If the installation program does not 
automatically start, then from the Start menu, select Run. 
Enter D:SETUP and click OK.  Be sure to change the drive 
letter to the letter for your CD drive. 

 
2) The AccuTerm 2000 Internet Edition installation wizard will 

guide through the installation process. You will be prompted 
to enter your authorization key, enter registration 
information, etc. You move forward through the installation 
process by clicking the Next button. You can click the Back 
button to move back, or the Cancel button to cancel the 
installation. 

 
3) Enter your Authorization Key, found on the back of the CD 

sleeve, and click Continue. 
 
4) Read the Software Server License Agreement and indicate 

your acceptance by clicking OK. 
 
5) The AccuTerm Registration dialog box will be displayed. 

Please fill in the registered company and server names, then 
click the Next button. 
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6) Select the directory where you want the AccuTerm program 
files to be installed, then click the Next button. Click the 
Browse button to change directories. If you already have 
AccuTerm 2000 installed on your computer, be sure to install 
AccuTerm 2000 Internet Edition into the same directory! 

 
7) Select the “home” directory, where you want to store the 

session files you create using the program. By default, 
AccuTerm Internet Edition stores the session files in the "My 
Documents\AccuTerm Internet Sessions" folder. 

 
8) You can choose if you want files which are replaced during 

installation to be saved in a backup directory. If you select 
this option, when you click the Next button, you can select 
the directory where replaced files are saved to. 

 
9) Select a “Start Menu” folder for the AccuTerm 2000 Internet 

Designer shortcut, then click the Next button. You can also 
place a shortcut to AccuTerm 2000 Internet Designer on your 
desktop. 

 
10) To begin installing files, click the Next button. The 

installation progress will be displayed. When the installation 
is complete, you can view the release notes by checking the 
“View release notes” box, and clicking Finish. If you do not 
want to view the release notes at this time, simply clear the 
“View release notes” box and click Finish. 

 
 

During installation, you may get a message indicating that the OLE system 
files are in use.  If this occurs, please shut down all other applications, then 
click the OK button to restart Windows. After Windows restarts, re-start 
the installation procedure. 
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Overview of AccuTerm 2000 Internet Edition 
 
 
AccuTerm 2000 Internet Edition is designed to let users access legacy host 
applications over the Internet by clicking on a hyperlink on a web page. 
The AccuTerm components are automatically downloaded and installed on 
the user’s computer by Internet Explorer. The terminal emulation settings 
are downloaded from the web server, and a Telnet or Secure Shell 
connection to your host is established inside the Internet Explorer browser 
window. You do not need to modify your application, and the user does not 
need to install any new programs to access your terminal-based 
application. 
 
AccuTerm 2000 Internet Edition consists of two components: the 
Connection Designer, which is used to create and modify AccuTerm 
Internet Session files, and the AccuTerm 2000 Internet Client, which is 
invoked by Internet Explorer to display the terminal session within the 
browser window. 
 
This manual describes how to create or modify AccuTerm 2000 Internet 
Sessions using the Connection Designer, how to deploy the session files 
and associated html code in a web page, and the terminal emulation 
features supported by the AccuTerm 2000 Internet Client. 
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Quick Start 
 
 
To get started quickly, make sure the minimum requirements for deploying 
AccuTerm 2000 Internet Edition are met: 
 
 1) The host you want to connect to is connected to the Internet (or 

intranet if creating a local connection) 
 
 2) You have access to a web server somewhere on the Internet 

where you can install the AccuTerm connection files. 
 
 3) The PC you are installing the AccuTerm 2000 Internet 

Designer program onto has Internet Explorer 4.0 or higher. 
 
Create a new connection 
Start the AccuTerm 2000 Internet Edition Connection Designer from the 
Start menu. Click the New button or select New from the File menu. 
Choose safe or unsafe connection. Enter a file name to save your new 
connection under. Click OK. 
 
Configure the new connection 
Click the Settings button or select Settings from the Tools menu. Enter 
your connection settings just as you would for a normal AccuTerm 
terminal session. 
 
Customize your connection script 
Click the Script Editor button or select Edit Script from the Tools menu 
if you want to customize the Connect or Disconnect script. 
 
Test your connection 
Click the Connect button, or select Connect from the Tools menu. See 
how your new connection works, including the Connect script. When you 
are finished, click the Disconnect button (or Disconnect from the Tools 
menu) and see if the connection terminates correctly. If you encounter any 
problems, adjust your settings or script until it works correctly. 
 
Save the connection file and HTML link file 
Click the Save button or select Save from the File menu. Check the 
appropriate HTML option (usually you will want to save the Internet 
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HTML file) and GUI option (only select if your host application requires 
AccuTerm GUI support). Click the Save button. 
 
Deploy your connection 
Upload your new connection (.ats) file and HTML link file to your web 
server. Modify an existing web page to link to the new HTML link file. 
Open the HTML link file with Notepad (or other text editor) and copy the 
sample link and paste into your web page to create the hyperlink. 
 
Try it! 
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CONNECTION DESIGNER 
 
 
The Connection Designer is used to create and maintain AccuTerm 
Internet Session files (.ats files). The session file contains all information 
required to make a to the host, including host name (or IP address), 
connect and disconnect scripts, terminal type, screen size, function keys, 
colors, etc. 
 
To start the Connection Designer, simply select 

 from the Start menu. The AccuTerm 
2000 Internet Edition Connection Designer main window will be 
displayed: 
 

 
 
The designer window is divided into two panes: the left pane contains a set 
of buttons for creating new sessions, opening existing sessions, etc. The 
right pane contains a preview of the terminal session as it would be 
displayed in the browser. 
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Creating and Modifying AccuTerm Internet 
Connections 

 
 
Creating a new connection 

To create a new session, select New from the File menu or click the  
button. When creating a new connection, you must select the session file 
name before the session file can be created. Use “.ats” for the file extension 
(if you use another extension, the Connection Designer may not recognize 
the file). After creating a new session file, the preview pane will display a 
preview of the terminal session. 
 
 
Safety Level 
When you create a new connection, you must also select the “safety” level 
for the connection you are creating. The safety level is used by the browser 
to warn the user if potentially unsafe content is about to be accessed, or to 
block access to potentially unsafe content. You can choose to create a safe 
or unsafe connection. 
 
When you choose to create a safe connection, AccuTerm’s functionality is 
restricted to protect the user’s computer from any actions which might alter 
any files or settings. A safe connection cannot perform file transfers, data 
capture, execute DOS/Windows command, or execute any script statement 
which could alter the user’s computer. 
 
The following VBA statements and functions are not supported in “safe” 
connections: 
 

Open Print Close 
Put Declare Shell 
Kill CreateObject GetObject 
ChDir ChDrive FileCopy 
MkDir Name RmDir 
SetAttr Write DDEInitiate 
DeleteSetting SaveSetting App… 

 
When you choose to create an unsafe connection, all of AccuTerm's 
features are available, but the browser will refuse to open the session file if 
the security level for the web site or zone is set to “High”. The user will be 
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warned that the site may damage his computer if the security level is set to 
“Medium”, but can proceed anyway by ignoring the warning. If you deploy 
an unsafe connection, remember to inform your potential users that the 
browser security level must be set to low or medium to view your page. 
 
To change the browser's security level, select Internet Options from the 
browser's Tools menu, then click the Security tab. You can also adjust the 
security level by double-clicking on the Internet icon in Control Panel. 
 
 
Modifying an existing connection 
To modify an existing session file, select Open from the File menu or click 

the  button.  After opening a session file, the preview pane will 
display a preview of the terminal session. 
 
 
Upgrading from AccuTerm 97 Internet Edition 
The AccuTerm 2000 Internet Connection Designer is capable of upgrading 
your existing session files which were created with the AccuTerm 97 
Internet Connection Designer. When you open a file created with the 97 
version, you will be given the option to convert the file to the 2000 version. 
Choose a new file name for the AccuTerm 2000 version of the connection 
file. 
 
The conversion process preserves all settings and scripts. However, due to 
changes made in the 2000 version, the "reconnect" message that is 
normally displayed when the connection is dropped requires a new 
Disconnected script function. This new function will be automatically 
added to your script. 
 
 
Closing a session file 
If you wish to close the session file you currently have open, select Close 

from the File menu or click the  button.  If you have made changes 
to the settings or script for the session, you will be warned before the file is 
closed so you can cancel your action and save the changes. 
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Saving a session file 
If you wish to save the current session file, select Save from the File menu 

or click the  button.  The process of saving also closes the file. If you 
have made changes to the settings or script for the session, you will be 
warned before the file is closed so you can cancel your action and save the 
changes. 
 
When you save the session file, you can also create an HTML link file 
which you can use as a hyperlink target in your current web page. The 
HTML link file can be either an “Internet” or an “intranet” version. 
 
If you choose “Internet” HTML, the generated link file will cause Internet 
Explorer to install the AccuTerm 2000 Internet Client programs on the 
user’s machine from AccuSoft’s web site. 
 
If you choose “intranet” HTML, the generated link file will cause Internet 
Explorer to install the AccuTerm 2000 Internet Client programs from the 
atiecli2.cab file located on the web server where the .ats session file is 
located. 
 
You can also choose to include special code in the HTML link file which 
will cause Internet Explorer to install the AccuTerm GUI support code. To 
reduce download time, select this option only if your host application uses 
AccuTerm GUI. If you are deploying AccuTerm 2000 Internet Edition on 
an intranet, and are using AccuTerm GUI, you must also place a copy of 
atguisvr_install.cab on your web server. 
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AccuTerm Internet Connection Settings 
 
 
Once a session file has been created or opened, use the Settings dialog to 
configure the session. To open the Settings dialog, select Settings from the 

Tools menu or click the  button. 
 
The Settings dialog is organized into nine categories, with each category 
on a separate index tab. Click on one of the index tabs to display the 
settings for that category. You can also press the number of the category 
while holding the ALT key. 
 
When you have completed your changes, simply press ENTER (or click the 
OK or Apply button) to save changes, or press ESC (or click the Cancel 
button) to discard changes and close the Settings dialog box. 
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Connection Settings 
 
 
Connection Method 
The Connection Method is used to select what type of connection or 
communications device you use between your computer and the host 
system. Since AccuTerm 2000 Internet Edition is designed to enable 
connections over the Internet (or intranet), you will normally select Telnet, 
or Secure Shell for the connection type. Only settings for Telnet and 
Secure Shell are described in this document; refer to the standard 
AccuTerm product documentation for information pertaining to other 
connection types. 
 
After selecting or changing the connection type, settings relating to the 
selected connection type are enabled. For example, if Telnet is selected, 
various options for a telnet connection, such as the host name, port and 
timeout will be enabled. The settings for each connection type will be 
described later in this section. 
 
Duplex 
There are three duplex options: Full, Half and Local. In Full duplex, all 
characters typed on your keyboard are sent to the host computer. They are 
not printed on the screen. The host usually sends (echoes) the same 
character back; this is what is displayed on the screen. This is by far the 
most common configuration. In Half duplex, the characters you type are 
sent to the host machine and displayed on the screen. If the host system is 
configured for Full duplex and you select Half duplex on your computer, 
you will see each character that you type two times!. In Local mode, 
characters you type are displayed directly on the screen and are not sent to 
the host computer. 
 
Strip Eighth Bit 
Most connection types use eight bits to represent each character. When 
using eight bits, the computer can send up to 256 different character codes. 
Some older host computers use the eighth bit for parity (an error detecting 
scheme used with serial communications), others may simply “set” the 
eighth bit for each character. 
 
Most terminal types accept 8-bit characters, and characters with the eighth 
bit set (character codes 128 - 255) usually represent international 
characters, line drawing symbols or other graphic symbols. 
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In order to communicate properly with older systems which do not use the 
eighth bit for data, select this option. When this option is selected, any 
character received from the host with the eighth bit set will behave just like 
the eighth bit is not set. 
 
 
 

Connection Settings - Telnet 
 
AccuTerm supports Telnet connections to host systems over a TCP/IP 
network.  Any Telnet server on the network (including hosts on the 
Internet) can be accessed. 
 
Host Name 
A valid TCP/IP host name or IP address must be entered in this field. If a 
hosts file is available, you can click on the down-arrow to display a list of 
available hosts. 
 
Host Type 
If your type of host you are connecting to is listed in the Host Type list, 
please select it, otherwise just use the default host type. By selecting a host 
type from this list, certain advanced options are set up to be compatible 
with the specified host type. To see the advanced options, click on the 
Advanced button. 
Port 
If the Port field is left blank, or set to “default”, AccuTerm will use TCP 
port 23 (the default for Telnet).  If a different port is used for Telnet on 
your desired host machine, enter that port number in this field. 
 
Certain host systems, such as Pick D3 and mvBase, allow a host process 
number (PIB) to be mapped to a specific TCP port number. You can use 
the Host Port setting to specify the port number mapped to your process 
number. Consult with your system administrator for this setting.  
 
Connect Timeout 
When establishing a connection to a host computer, AccuTerm will wait 
for a specified time for a response from the selected host system. You can 
specify the number of seconds AccuTerm should wait.  If this field is left 
blank, or zero, the default timeout is 15 seconds. 
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Advanced Options 
By clicking on the Advanced… button, you can modify various Telnet 
options. These options are generally set by selecting a Host Type, but may 
be modified if necessary. 
 
If you change any settings in the Advanced Telnet Options, the host type 
you have previously selected will be changed to “custom”. 
 
Echo (advanced option) 
Most systems require the host to “echo” characters it receives back to the 
client (terminal).  That is, when you press a key, a character is sent to the 
host, and the host sends that same character back to the terminal, at which 
time it is displayed on the screen.  If this behavior is desired, then select 
the echo option (default).  If the echo option is not selected, then the 
Duplex setting should be changed to “half” to enable local echo of typed 
characters. 
 
Binary (advanced option) 
When the binary option is selected, data is transferred between the host and 
terminal without modification.  This is useful when transferring binary 
data such as graphics.  When this option is not selected, the Telnet protocol 
treats CR characters in a special way, inserting a NUL character after any 
CR character while sending data to the host, and removing the extra NUL 
character when receiving data from the host.  Note: when this option is 
selected, some servers expect lines to be terminated with LF instead of CR.  
 
Use alternate break signal (advanced option) 
When this option is selected, pressing the CTRL+BREAK sends the Telnet 
Break command. Otherwise the Telnet Interrupt Process (default) 
command is sent. 
 
Bypass option negotiation (advanced option) 
When this option is selected, Telnet option negotiation, which normally 
occurs when establishing a connection, is skipped. Certain Telnet servers, 
like Pick’s D3, do not support Telnet option negotiation, and require this 
option. 
 
Send keepalives 
When this option is selected, AccuTerm will send a dummy “keepalive” 
message to the host periodically (about every 2 minutes). This dummy 
message is discarded by the host and is transparent to the terminal session. 
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This feature may be useful when the host system (or network equipment 
such as a router) disconnects an idle connection. 
 
Note: certain Telent servers, like Pick’s D3 running on NT, do not work 
properly when receiving AccuTerm’s dummy keepalive messages. 
 
Disable outbound coalescing 
Use this option to improve terminal response over the network, at the 
expense of increased network traffic. 
 
Use U2 device licensing 
By selecting this option, multiple connections (sessions) to Enterprise 
versions of UniData and UniVerse consume only a single user license. This 
option is only available when the u2licn.dll file is installed on your 
computer. The u2licn.dll file is not available from AccuSoft.  Contact your 
Informix/Ardent dealer for information regarding device licensing. 
 
Terminal Type (advanced option) 
Many Telnet servers allow the client (terminal) to specify a terminal type 
when a connection is established.  AccuTerm uses the default terminal 
types of tty, viewpoint, viewpoint60, wyse50, wyse60, vt100, vt220, vt320, 
vt420, vt52, ansi, linux and pickmon, depending upon the selected 
terminal emulation.  If a different terminal type is required, you can enter 
it in this field. 
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Connection Settings – Secure Shell (ssh) 
 
AccuTerm supports secure connections to host systems over a TCP/IP 
network using Secure Shell (ssh).  Any ssh server on the network 
(including hosts on the Internet) can be accessed. 
 
Secure Shell employs public key encryption technology to ensure that your 
connection to the host is secure, even over the Internet. When you set up a 
Secure Shell connection, all information, including your user ID, password 
and session data is encrypted before transmission over the network. 
 
In order to create a connection using Secure Shell, you must have Internet 
Explorer with 128 bit encryption installed on your computer. To verify that 
you have the 128 bit encryption installed, open Internet Explorer, and 
select About Internet Explorer from the Help menu. If Cipher Strength is 
128-bit, then you should be able to create a Secure Shell connection. If it is 
not, you may need to upgrade you version of Internet Explorer and/or 
install the High Encryption Pack (available on Microsoft’s web site at 
www.microsoft.com/windows/ie). 
 
Host Name 
A valid TCP/IP host name or IP address must be entered in this field.  If a 
hosts file is available, you can click on the down-arrow to display a list of 
available hosts. 
 
Port 
If the Port field is left blank, or set to “default”, AccuTerm will use TCP 
port 22 (the default for ssh).  If a different port is used for ssh on your 
desired host machine, enter that port number in this field. 
 
Connect Timeout 
When establishing a connection to a host computer, AccuTerm will wait 
for a specified time for a response from the selected host system. You can 
specify the number of seconds AccuTerm should wait.  If this field is left 
blank, or zero, the default timeout is 15 seconds. 
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Advanced Options 
By clicking on the Advanced… button, you can modify various Secure 
Shell options. 
 
Break character (advanced option) 
Specify the character used to indicate a Break in this field. The default is 3 
(CTRL + C). 
 
Terminal Type (advanced option) 
Many Telnet servers allow the client (terminal) to specify a terminal type 
when a connection is established.  AccuTerm uses the default terminal 
types of tty, viewpoint, viewpoint60, wyse50, wyse60, vt100, vt220,vt320, 
vt420, vt52, ansi, linux and pickmon, depending upon the selected 
terminal emulation.  If a different terminal type is required, you can enter 
it in this field. 
 
Send keepalives 
When this option is selected, AccuTerm will send a dummy “keepalive” 
message to the host periodically (about every 2 minutes). This dummy 
message is usually discarded by the host and is transparent to the terminal 
session. This feature may be useful when the host system (or network 
equipment such as routers) disconnects an idle connection. 
 
Disable outbound coalescing 
Use this option to improve terminal response over the network, at the 
expense of increased network traffic. 
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Terminal Type Settings 
 
 
AccuTerm emulates a variety of terminals.  In order to use AccuTerm with 
your host applications, you must select the correct terminal type for 
AccuTerm to emulate. The correct terminal type depends on the terminal 
type your host and/or application software requires. If you are unsure, you 
might type “TERM” at a Pick command (TCL) prompt, or type “echo 
$TERM” at a Unix command prompt. The response may help you “guess” 
the correct type. If the application screens look correct, then you probably 
have the correct type; otherwise, try another terminal type. 
 
Terminal Emulation 

 

Wyse 50: emulates a Wyse 50 terminal with “Enhanced” enabled. 
Wyse 50 emulation may also be used for Wyse 30, 99, 125 and 350 
terminals. 

Wyse 60: emulates a Wyse 60 terminal with “Enhanced” enabled. 
Wyse 60 emulation is similar to Wyse 50 with non-embedded visual 
attributes (the visual attribute codes do not take a position on the 
screen). Wyse 60 emulation may also be used for Wyse 150, 160 and 
320 terminals. 

ADDS Viewpoint A2: emulates an ADDS Viewpoint A2 terminal. 
This is the original A2 terminal, with no enhancements. 

ADDS Viewpoint 60: emulates an ADDS Viewpoint 60 terminal. The 
Viewpoint 60 is similar to the A2, but uses embedded visual attributes 
(the visual attribute codes take a position on the screen). 

Procomm VP60: emulates an ADDS Viewpoint 60 terminal, but with 
non-embedded visual attributes. This emulation is similar to the 
Viewpoint 60 emulation provided by Procomm. 

Viewpoint A2 Enhanced: emulates a Wyse 50 terminal in ADDS 
Viewpoint mode with “Enhanced” enabled. This is basically a hybrid 
of Wyse 50 and ADDS Viewpoint A2. Viewpoint A2 Enhanced may 
also be used for ADDS 2020 and 4000, and NCR 2900 terminals. 
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VT52: emulates the DEC VT52 terminal. 

VT100: emulates the DEC VT100 terminal. VT100 is a 7-bit 
emulation, and can also be used for applications which require VT102 
terminals. 

VT220: emulates the DEC VT220 terminal. The VT220 emulation 
provides a super-set of the VT100 commands, and includes support for 
a host-writable status line, protected characters, multiple character sets 
and multiple pages. 

VT320: emulates the DEC VT320 terminal. The VT320 emulation 
provides a super-set of the VT220 commands, and includes support for 
reporting and restoring various terminal states. 

VT420: emulates the DEC VT420 terminal. The VT420 emulation 
provides a super-set of the VT320 commands, and includes support for 
rectangle operations, left & right margins, and horizontal split screen. 

ANSI BBS: emulates the old MS-DOS ANSI.SYS device driver. This 
emulation may be useful when connecting to older bulletin board 
systems. 

Linux Console: emulates the Linux console, including function keys 
and colors. 

SCO Console: emulates the SCO Unix console. 

Pick PC Monitor: emulates the original Pick PC Monitor (“mm-mon” 
or “I” terminal type), including color and function keys. 

Tektronix Graphics: emulates the Tektronix 4010/4014 and partial 
41xx terminals. Color enhancements as implemented in the CIT467 
terminal (from CIE Electronics) are included.  

TTY Emulation: emulates basic TTY functions. 

 

Answerback 
The contents of the Answerback field are sent to the host when AccuTerm 
receives a request to transmit the answerback string under Wyse and VT 
emulations.  When the answerback message is sent to the host under Wyse 
emulation, an ACK control character follows the message.  Under VT 
emulation, no terminator is sent. 
 
Control characters may be entered into the answerback field by prefixing 
the character with a caret (^). 
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ANSI Options 
When any of the ANSI emulations (VTxxx, Linux Console or SCO 
Console) is selected, several additional options may also be selected. 
 

Send 8 bit controls 
When this option is selected, AccuTerm will send control 
characters from the C0 and C1 sets. If the option is not set, C1 
controls are sent using an equivalent 7-bit escape sequence. 
 
Keypad sends application codes 
When this option is selected, the numeric keypad sends 
application codes (similar to function keys). When not selected, 
the numeric keypad sends numbers. 
 
Cursor keys send application codes 
When this option is selected, the cursor (arrow) keys send special 
application codes instead of cursor movement codes. 
 
Backspace key sends DEL 
When this option is selected, the BKSP key sends the DEL control 
code. When not selected, the BKSP key sends the BS control code. 
 



 

 Connection Designer 23 

 
 
 

Screen Settings 
 
 
The Screen tab lets you set terminal screen options like the size, cursor 
type, and history rows. You can also change the session title or the icon 
used for a minimized session. 
 
Screen Sizes 
There are two separate screen sizes that AccuTerm supports; normal and 
extended. These sizes are used to emulate the 80 and 132 column modes of 
the Wyse and VT terminals. AccuTerm has taken the extended and normal 
modes one step further. With AccuTerm you can define both the normal 
and extended modes to be any number of columns or rows up to a 
maximum of 160 columns by 60 rows. 
 
You will probably leave these settings at their default settings of 80 
characters by 24 rows for normal mode and 132 characters by 24 rows in 
extended mode. If you have software that supports other screen sizes, you 
can experiment with these settings until you find a size that you like. 
 
AccuTerm always allocates one extra row for function key labels, host 
messages, etc.  If you specify 24 rows here, AccuTerm will display 24 data 
lines and one message line (the Pick PC Monitor and ANSI BBS 
emulations display 25 data lines). 
 
When AccuTerm switches between the normal and extended modes, one of 
two things will happen: either the characters will change size to fit the 
visible screen, or scroll bars will be displayed if the full screen will not fit 
within the current window at the selected character size. For more 
information on scaleable fonts, see the section on Fonts. 
 
Video Pages 
Many of the terminals AccuTerm emulates support multiple addressable 
pages. With AccuTerm, you can have up to 25 pages. Each page requires 
memory, so if you don't use them, it is better to leave this number set to the 
default value of 1. 
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History Rows 
AccuTerm supports a “history buffer”, which saves lines that have scrolled 
off of the terminal screen.  To use this feature, specify how many rows (up 
to 2500) are to be saved.  When the history buffer has been enabled (by 
setting the number of rows), use the vertical scroll bar, mouse wheel, or 
keyboard commands to scan history. 
 
You can use CTRL + SHIFT + PGUP, CTRL + SHIFT + PGDN, CTRL + SHIFT + UP, 
CTRL + SHIFT + DOWN, CTRL + SHIFT + HOME, and CTRL + SHIFT + END to scan 
the history buffer. 
 
History Scroll Bar 
When a history buffer has been enabled, the vertical scroll bar may used to 
scan through the history. AccuTerm supports three scroll-bar settings. 
 

Auto: when “Auto” (the default mode) is selected, placing the mouse 
near the right edge of the screen will cause the scroll bar to “slide” 
into place. Moving the mouse away from this area causes the scroll bar 
to disappear. 

On: when “On” is selected, the scroll bar will always be present. 

Off: when “Off” is selected the scroll bar will only be present if the 
window height is not large enough to display the current screen 
height. 

 
Note: when Auto or Off are selected, using the keyboard commands or 
mouse wheel to scan history causes the scroll bar to be displayed briefly. 
This is so that you can see the position of the scroll button after scrolling 
the window. 
 
 
Enable Graphic Mode 
Checking this box enables the Tektronix 4010/4014/41xx graphic terminal 
emulation. If the graphics mode is enabled, AccuTerm will automatically 
switch to the Tektronix graphic emulation when it receives the appropriate 
command from the host computer. AccuTerm will return to the previous 
emulation mode when graphics mode is terminated. 
 
There may be times when you want to disable the graphic emulation. If you 
have a bad modem connection and are getting random garbage characters 
on the screen, AccuTerm may accidentally switch into graphics mode. 
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Sometimes a software program may send the graphics mode control 
sequence at the wrong time. If this happens, disable the graphics mode 
until you need it. 
 
Enable Mouse 
This option determines whether host mouse support is enabled. Under 
normal operation, if you click on the terminal screen with the mouse, 
nothing happens. If a “mouse on” command is received from the host 
while this option is checked, AccuTerm sends a special code informing the 
host of the mouse location when the button was pressed, and which mouse 
button was pressed. The mouse cursor is also changed to a “pointing hand” 
to indicate that the mouse is active. 
 
Block Cursor 
Checking this option turns the cursor into a blinking block instead of an 
underline. 
 
Extended Mode 
Checking this option sets the screen to extended (132 column) mode. This 
can be used to manually switch between extended and normal (80 column) 
modes. 
 
Disable Line Wrap 
Checking this option disables the automatic wrapping at the end of a line. 
When this option is set, when the cursor is on the last position of a line, 
typing a character does not wrap to the next line. 
 
Disable Blinking 
Checking this option disables the “blinking” visual attribute. 
 
Disable Underling 
Checking this option disables the “underline” visual attribute.  
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Font Settings 
 
 
AccuTerm displays text received from the host computer using a fixed-
pitch (all characters are the same size) font. Using a fixed-pitch font is 
necessary because applications written to display on real terminals expect 
each character to be the same width in order to align columns of data on 
the screen. 
 
AccuTerm supplies a custom font which is selected by default. You are free 
to choose another fixed-pitch font if you desire, however, AccuTerm’s font 
has been designed to scale nicely to different screen sizes. 
 
Font 
The font list shows all of the available fixed-pitch fonts installed on your 
computer. The first font listed is the AccuTerm font. This font has been 
optimized to look good over a wide range of character sizes and screen 
resolutions. We recommend that you use this font, especially if you have a 
low resolution screen (640 x 480). 
 
To choose a different font, simply click on the font you want. 
 
Font Size 
This box lists all font sizes available for the font selected in the Font list. 
The Font Size list is disabled if the Scale Font to Fit option is checked. 
 
Scale Font to Fit 
When this option is checked, AccuTerm automatically re-sizes the selected 
font so that the entire terminal screen is visible. This allows you to re-size 
the screen or change between normal and extended video mode without 
having to deal with scroll bars to see everything. However, if for some 
reason, you need lock the characters at a specific size, you can un-check 
this setting and then pick the size you want from the Font Size list. 
 
Use Bold Font Style 
If this option is checked, AccuTerm uses the Bold font style if it's available 
in the selected font. 
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Keep Font Legible 
If this option is checked, and the Scale Font to Fit option is checked, 
AccuTerm will never scale a font smaller than 6 pixels wide by 9 pixels 
high. 
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Color Settings 
 
 
Windows is capable of displaying text in a wide variety of colors. The 
colors are separated into character color and the background color. Most of 
the terminals being emulated do not support color. Instead, they have 
visual attributes like normal, reverse, dim, blink, underline, etc. AccuTerm 
allows you to map the various terminal visual attributes into a combination 
of character and background colors. 
 
Color Palette 
 
AccuTerm uses a palette of 16 colors. Since most systems are capable of 
displaying more than 16 colors, AccuTerm allows you to customize its 
palette by using the “System” color settings as chosen in the Appearance 
tab of your Display properties (right-click on your desktop and select 
Properties, then click on the Appearance tab). To use the System colors, 
click the Use System Colors button. 
 
You can also create you own custom palette. To adjust one of the palette 
entries, double-click on one of the palette colors shown in the Character 
Color or Background Color samples. The “Choose Color” dialog box will 
be displayed. In the “Choose Color” dialog, you can select a system color, 
standard color, or custom color. The system colors are described in the 
previous paragraph. The standard colors are the 16 original palette colors 
(except for dark gray, which is a custom color). To choose a custom color, 
click the Select Custom Color button and select a color from the entire 
spectrum of available display colors. 
 
To restore the palette to AccuTerm’s default colors, click on the Use 
Defaults button. 
 
Note: if you modify the palette, explicit color commands used in some 
emulations may display the wrong color. For example, if you change the 
light-blue palette color to green, then an application which uses a color 
command to select light-blue text will instead display the text in green!  
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Color Mapping 
 
Terminals use visual attributes (normal, dim, blink, etc). to highlight text. 
AccuTerm supports these visual attributes, and also allows you to map the 
attribute to a character and background color combination. 
 
To change the color mapping, first click on the Visual Attribute whose 
colors you want to change. The sample box to the right of the attribute 
name shows the current color combination selected for that attribute. Next, 
click on the desired character and background colors in the palette shown 
at the bottom of the dialog box. The selected character and background 
colors are indicated by a large X in the palette. 
 
The Wyse 50 and Wyse 60 emulations require a visual attribute to be 
assigned as the “Protected” attribute. To select the Protected Attribute, 
click on the drop-down arrow, then select which visual attribute should be 
used as the default protected attribute. 
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Keyboard Settings 
 
 
AccuTerm supports a programmable keyboard. All of the function keys and 
most of the keypad editing keys can be programmed. 
 
Each terminal type has default programming for all of the keys which are 
native to that terminal. You do not need to program the default key codes. 
 
If you wish to override the default programming, or to program keys that 
are not native to the currently selected terminal type, you can enter you 
own codes here. Any key can be programmed with a character sequence 
(which is transmitted to the host when the key is pressed), or a macro 
command, which is executed when the key is pressed. 
 
The programmable keys are divided into eight categories: Normal, 
Shifted, Control, Shift+Control, Alt, Shift+Alt, Keypad and Shifted 
Keypad. The Normal key sequence is sent when one of the function keys 
is pressed by itself. The Control sequence is sent when a function key is 
pressed while holding down the CTRL key. The Alt sequence is sent if the 
ALT key is held down while pressing a function key. The Keypad sequence 
is sent when one of the editing keys is pressed. The Shifted, 
Shift+Control, Shift+Alt, and Shifted Keypad sequences are sent when 
the SHIFT key is held down in combination with any of the previous keys. 
 
The Keypad and Shifted Keypad tabs are used for programming the 
special editing keys: BKSP, TAB, INS, DEL, HOME, END, PGUP, PGDN, LEFT, 
RIGHT, UP, and DOWN. 
 
To reset the selected group of keys to their default values, click the Clear 
All button. 
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To manually program function and keypad keys,  first select the Key Type 
from the tabs at the top of the panel. Next, enter the desired sequence into 
the text box next to the key name. To enter control characters (and special 
prefix characters) in a key sequence, use the notation shown in the 
following table: 
 
 
 

Key 
sequence 

Control 
code 

AccuTerm 
notation 

Key 
sequence 

Control 
code 

AccuTerm 
notation 

CTRL + @ NUL ^@ CTRL + P DLE ^P 

CTRL + A SOH ^A CTRL + Q DC1 ^Q 

CTRL + B STX ^B CTRL + R DC2 ^R 

CTRL + C ETX ^C CTRL + S DC3 ^S 

CTRL + D EOT ^D CTRL + T DC4 ^T 

CTRL + E ENQ ^E CTRL + U NAK ^U 

CTRL + F ACK ^F CTRL + V SYN ^V 

CTRL + G BEL ^G CTRL + W ETB ^W 

CTRL + H BS ^H CTRL + X CAN ^X 

CTRL + I HT ^I CTRL + Y EM ^Y 

CTRL + J LF ^J CTRL + Z SUB ^Z 

CTRL + K VT ^K CTRL + [ ESC ^[ 

CTRL + L FF ^L CTRL + \ FS ^\ 

CTRL + M CR ^M CTRL +] GS ^] 

CTRL + N SO ^N CTRL + ^ RS ^~ 

CTRL + O SI ^O CTRL + _ US ^_ 
^  ^^ \  \\ 
DELETE DEL ^?    
 
 
To program a key with a macro, enclose the macro command in square 
brackets ([ ]). See the Scripting section of the Programmers Guide for 
more information on macros. 
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Locking Programmed Keys 
Most terminal types provide commands for the host to program function 
keys. If you would like the host to be able to reset and reprogram the keys, 
select the Unlocked – host can reset or reprogram key option. If you 
would like the host to be able reprogram keys, but not reset them to their 
default values, select the Locked – host cannot reset keys to defaults 
option. If you would like to prevent the host from resetting or 
reprogramming key, select the Locked – host cannot reset or reprogram 
keys option. 
 
Mapping F11 through F16 
Some terminals (like Wyse 50 and 60) have more than 12 function keys on 
their native keyboard. Since the PC keyboard only has 12 function keys, 
AccuTerm allows you to map the native F11 through F16 keys to PC 
keyboard CTRL + F1 through CTRL + F6 (and native SHIFT + F11 to SHIFT + 
F16 to PC CTRL + SHIFT + F1 through CTRL + SHIFT + F6). 
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Printer Settings 
 
 
AccuTerm 2000 uses the printer in two ways: First, AccuTerm can print 
the contents of the terminal screen by using Print Screen context menu 
command or by receipt of the appropriate command from the host 
computer. 
 
The other way AccuTerm uses the printer is to emulate a “slave” or “aux” 
printer attached to a terminal’s Aux, or Printer port. This mode is enabled 
by using the Printer On context menu command or by receipt of the 
Printer On command from the host. 
 
AccuTerm can print in two modes: text and graphics. Text is the mode 
used by “real” terminals. This mode is different from normal Windows 
printing in that the Windows printer driver is not used. For screen 
printing, text mode sends the screen text to the printer. For slave printing, 
AccuTerm passes raw data, including control characters and escape 
sequences from the host directly to the printer (or spooler). In text mode, 
the host computer is responsible for setting printer font sizes and page 
orientation by sending the appropriate printer commands. 
 
In graphics mode, AccuTerm prints an image of the screen on the printer, 
using the Windows printer driver. When the screen is printed in graphics 
mode, the printed image includes text, line drawing characters, and may 
optionally include the screen background and colors. For slave printing, 
AccuTerm understands CR (carriage return), LF (line feed) and FF (form 
feed) control characters, but other control characters and escape sequences 
are ignored. You can select the font, paper size and page orientation used 
for graphics mode slave printing by clicking the Page Setup button in the 
printer settings panel. 
 
 
Printer Selection 
By default, AccuTerm uses the system default printer (the Use Windows 
Default Printer option selected). If you want to select a different printer, 
select the Use Specific Printer option, then select a printer from the drop-
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down list. If you want to disable printing from AccuTerm, select the 
Disable printing option. 
 
 
Screen Print Settings 
AccuTerm can print the screen in Text or Graphics modes. In Text mode, 
only the text characters currently displayed on the screen are printed. In 
Text mode, you can elect to eject the page from the printer before the 
printout, after the printout or both. 
 
In Graphics mode, an “image” of the current screen is printed, including 
special symbols like line drawing characters. You can elect to print the 
background (shading and highlighting) or print the screen in color if you 
have a color printer. 
 
 
Slave Printer Settings 
AccuTerm can print to the slave printer in either Text or Graphics mode. 
In Text mode, you can eject the page from the printer before the printout, 
after the printout or both. In Graphics mode, you can select the font, page 
orientation, paper size and paper source by clicking the Page Setup button. 
 
Printer Close Timeout 
Enter the number of seconds to wait after receiving a Printer Off command 
before closing the print job. Usually, when the host computer needs to print 
a report, it usually sends a Printer On command, sends the printer data and 
then sends a Printer Off command. But some host programs send a Printer 
On command, send some data to the printer, send a Printer Off command, 
and send some other data to the screen, and then send another Printer On 
command, and send more data to the printer, etc. Because of this, 
AccuTerm has no way of knowing when the host is finished sending the 
print job. The only way it can determine this is to wait for a set amount of 
time after the Printer Off command before closing the job. If this field is set 
to the default of 5 seconds, AccuTerm waits 5 seconds after the Printer Off 
command has been received before closing the print job. 
 
This causes a delay when printing under AccuTerm. If all your host 
programs always turn the aux port on, send all the data and then turn it off, 
you can reduce this number to 1 or 0. If you have programs that are 
constantly turning the aux port on and off, you may need to adjust this 
number until things work correctly. 
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File Transfer Settings 
 
 
AccuTerm supports several file transfer protocols. The File Transfer tab 
allows you to adjust some of the parameters used control the various 
protocols, select default operating modes and specify default directories.  
There are sections for ASCII options, X/Y/Zmodem options, Kermit 
options, as well as options for default modes and directories.  The default 
values for most of these options should not be changed without an 
understanding of the protocol and the companion file transfer program on 
the host computer. 
 
 
ASCII Settings 
When transferring a file from your computer to the host computer (upload) 
using the ASCII protocol, the each line may be terminated with a CR, LF or 
CR LF combination.  Select the appropriate end of line for the host 
computer by checking the appropriate button. 
 
ASCII is a “blind” protocol.  The receiving computer cannot inform the 
sending computer when it is safe to transmit data.  In order to perform 
reliable ASCII uploads, you may need to specify an appropriate Interline 
delay time.  After each line is sent to the receiving computer, AccuTerm 
will wait for the specified time before sending the next line.  Specify this 
value in milliseconds. 
 
The Interline delay setting also applies to the Edit Paste and Edit Paste 
From commands. 
 
Timeout Settings 
When using any of the X/Y/Zmodem protocols, you can specify the number 
of seconds before a timeout occurs.  If the other machine fails to respond 
within the number of seconds specified here, the protocol will attempt to 
resend the previously sent message. 
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Kermit Settings 
The Kermit file transfer protocol is popular with minicomputer and 
mainframe systems.  There have been many revisions of this protocol, and 
it may be necessary occasionally to modify some of these settings to 
communicate with another Kermit program. 
 
Kermit settings: Defaults 
These default options may be set (checked) or reset (un-checked) as 
desired.  When AccuTerm Kermit is negotiating with the other Kermit 
program, any of the checked options will be requested, and if the other 
Kermit is capable, the option will be used. 
 
The “Quote eighth bit” option should be used when the communications 
path only supports 7 data bits, or when the other machine is not capable of 
processing eight bit data. 
 
The “Compress data” option may be used to perform rudimentary data 
compression.  Not all Kermit programs perform data compression. 
 
The “CRC block check” option instructs Kermit to use CRC error detection 
instead of the standard simple checksum error check.  This results in more 
reliable transfers, especially over noisy phone lines.  Not all Kermit 
programs perform CRC error checking. 
 
Default Mode 
Select Text or Binary as the default transfer mode (used only for Kermit 
and Zmodem protocols).  When you select Upload or Download from the 
main menu or toolbar, the default mode will be selected.  Also, select 
whether to overwrite existing files when downloading.  You also can 
change any of these options in the Upload or Download dialog before 
performing the transfer. 
 
Default Upload/Download Directory 
Enter the drive and directory where you want received files to be stored by 
default.  You can change this directory in the Download dialog before 
performing the transfer.  If you set the Automatic Zmodem download 
option, then this is the directory where the received files are stored. 
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Automatic Zmodem Download 
If this option is set, then AccuTerm will automatically begin receiving files 
using the Zmodem protocol when the other machine begins sending files 
using the Zmodem protocol.  The files are saved in the Default 
Upload/Download directory. 
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Miscellaneous Settings 
 
 
The Miscellaneous Settings tab is used for setting various options, such as 
how paste operations are handled and the sound of the terminal bell. 
 
 
Paste Options: line end 
When the clipboard is “pasted” to an AccuTerm session, AccuTerm 
transmits the clipboard text to the host computer. The line end options 
specify what is transmitted at the end of a line of text. Options include CR 
(default), LF, CF+LF, TAB, none or a user-defined character. To specify a 
user-defined character, select the User defined option and enter the ASCII 
code of the character to be transmitted at the end of each line. 
 
Paste Options: do not send line end after last line 
If you want to suppress the final end-of-line (or only end-of-line if only a 
single line is in the clipboard), select this option. 
 
Paste Options: paste end 
After pasting the clipboard to an AccuTerm session, AccuTerm can 
transmits an optional paste end character. Normally, AccuTerm does not 
transmit any character at this time, but you can select EOF (which is the 
SUB  or CTRL + Z control code), or a user-defined character. To specify a 
user-defined character, select the User defined option and enter the ASCII 
code of the character to be transmitted at the end of a paste operation. 
 
Terminal Bell Sound 
The sound generated by AccuTerm upon receipt of the ASCII BEL control 
code can be customized. The default sound depends upon whether a sound 
card is installed or not. If a sound card is not installed, a “beep” is 
produced; otherwise the sound defined by the Control Panel Sounds applet 
as the “Default Beep” is played. 
 
Other options which may be selected are: play wave file, system event, 
beep or silent. To play a wave file, select this option and enter the full path 
for the wave file to be played. To use a sound associated with a system 
event, select the event from the dropdown list. System events are associated 
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with wave files in the Control Panel Sounds applet. To use a true beep, 
enter the frequency of the beep in Hz, and the duration in milliseconds. 
The default is 400Hz for 500ms. The frequency must be between 200Hz 
and 4000Hz. The duration must be between 100ms and 5000ms. 
 
Advanced (Custom Features) 
Click the Advanced button to show any custom features that can be 
selected. See the Programmers Guide for more information on the custom 
features of AccuTerm 2000. 
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AccuTerm Internet Connection Script 
 
 
AccuTerm 2000 Internet Edition uses a script, written in Visual Basic for 
Applications (VBA), to automate certain processes. Each session file 
includes its own script, which may be customized. When a new session file 
is created, a default script is also created for that connection. To open the 
Script Editor window, select Script from the Tools menu or click the 

 button. 
 
In AccuTerm 2000 Internet Edition, scripts are used to automate the logon 
process as well as for cleanup. Scripts may also be called by the host 
program, or invoked by a function key (as programmed in the Keyboard 
section described previously). 
 
The Connect()  subroutine is called when AccuTerm has successfully 
established a connection with the host system. Modify the default script to 
log into your host system and start the application you want the user to 
have access to from the web. 
 
Various blocks in the default Connect() subroutine can be “un-
commented” to support either hard-coded user ID and password, or prompt 
for user ID and password. The login sequence uses a series of Output 
statements (methods) to send a string to the host followed by WaitFor 
statements (methods) to wait for the desired response from the host. You 
will probably need to customize this section. 
 
The Disconnect() subroutine is executed when the AccuTerm session 
is closed. This function is designed to handle any special cleanup 
functions. Since the connection is probably already closed, often there is 
not much you can actually do in this function. The default 
Disconnect() subroutine performs no function. 
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The Disconnected() subroutine is executed when the connection to 
the host has been terminated, either deliberately by the host, or due to 
network errors. This function can be used to display a message to the user, 
close the browser window, etc. There are two predefined actions in the 
standard sample script: display a “reconnect” message or close the browser 
window. 
 
You can create other subroutines and functions which are called by your 
Connect() or Disconnect()routine (or from function keys or host 
commands). Subroutines begin with the Sub keyword followed by the 
name of the subroutine. If the subroutine requires arguments, enclose them 
in parentheses. The last statement in a subroutine is End Sub. 
 
Functions are similar to subroutines, and begin with the Function 
keyword, and end with the End Function statement. Functions return a 
value; simply assign the return value to the function name within your 
function code. 
 
 
Controlling AccuTerm with Scripts 
From a script’s perspective, AccuTerm consists of a set of objects which 
can be manipulated. The main object, AccuTerm, may be used to control 
the general settings of AccuTerm. The Session object is the most useful 
object for controlling AccuTerm. Using the Session object, you can 
change any of the session settings, communicate with the host system, 
manipulate the screen, etc. Note that not all properties and methods of all 
objects are available or meaningful in the context of an AccuTerm Internet 
session. For example, the AccuTerm.WindowState property is not relavent 
in this context and will generate an error if used. See the AccuTerm 
Object Reference chapter in the Programmers Guide for a description of 
AccuTerm’s object model. 
 
There are several built-in objects which can be referenced while executing 
scripts. These are the AccuTerm object and the ActiveSession object. 
 
For compatiblity with the standard version of AccuTerm 2000, the 
Sessions collection and the InitSession object are also defined, 
however, the Sessions collection contains exactly one session and no 
other sessions may be added to it, and the InitSession object 
references the same session as the ActiveSession object. 
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Cookies 
The Cookie collection provides a method to communicate values between 
the HTML session and the emulator session. Cookies which are passed 
between HTML and emulator sessions must be “permanent”, or “disk” 
cookies, not “temporary” or “memory” cookies. The scope of cookies is 
restricted to the URL of the directory of the session (.ats) file. 
 
You can retrieve the value of a “cookie” which was set by the web server 
(or by a script in the HTML page) by accessing the Cookie collection: 
 
 x$ = Cookie("MyCookie") 
 
Likewise, you can set the value of a cookie so that the web server (or a 
script in the HTML page) can retrieve its value: 
 
 Cookie("HostResult") = "Success" 
 Cookie("AccountNumber", 1800) = "11199" 
 
The second form specifies the expiry time of the cookie in seconds. In the 
example, the cookie is valid only for 30 minutes (1800 seconds). If you do 
not specify an expiry time, the default of 1 hour is used. 
 
 
WebBrowser Object 
An object representing the browser containing the emulator session (.ats 
file) is available as the WebBrowser object. While much functionality of 
this object is restricted, the Quit and Navigate methods are available 
and might be useful in some circumstances. For example, you can use the 
Quit method in the Disconnected function to close the current 
browser window (the one displaying the terminal session). This is actually 
one of the choices in the sample script: 
 
 WebBrowser.Quit 
 
 
For more information on scripting, or the AccuTerm object model, please 
refer to the Programmers Guide. 
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Testing a Connection 
 
 
After configuring the connection settings and script, you can use the 
Connection Designer to test your connection file. Normally, the terminal 
session in the preview pane is “disconnected” from the host. To connect to 

the host, select Connect from the Tools menu or click the  button. 
AccuTerm will attempt to connect the host configured in your connection 
file, and once connected, the Connect subroutine in your script will be 
executed. In the Script Editor window, you may set break-points in your 
connection script to aid in debugging the script. 
 
 
To test the Disconnect script, select Disconnect from the Tools menu 

or click the  button. 
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DEPLOYING ACCUTERM INTERNET 
CONNECTIONS 

 
 

Deploying an AccuTerm 2000 Internet Connection on the Internet (or on 
an intranet) requires two components: a Web Server and the Host 
Computer that you want to connect to. 
 
 

Web Server 
 
 
After you create a terminal session (.ats) file with the Connection 
Designer, you need to link the new terminal session into your web page. 
Choose an appropriate web page, and modify the web page file by adding a 
hyperlink to the new HTML link file (created when you saved your .ats 
file). The HTML link file contains a sample hyperlink which you can copy 
and paste into your web page file. Then, upload the modified web page file, 
the .ats file and the HTML link file to your web server. 
 
The web server does not need to be (and usually is not) the same machine 
as your host. The web server can be located anywhere on the Internet (or 
intranet), as long as end-user's PC can access it. The only function that the 
web server performs when used with AccuTerm 2000 Internet Edition is to 
deliver the HTML and .ats files to the browser on the user's PC. 
 
If you install the ats file on a local (intranet) web server, and you have 
selected the intranet version of the HTML link file, you also need to upload 
the atiecli2.cab file from the ...Atwin\LocalServerFiles directory to your 
web server. If your HTML link file includes the GUI support option, you 
should also upload the atguisvr_install.cab file to your web server. 
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Host Connection 
 
 
The final task required to get everything working is to connect your host to 
the Internet (or intranet). It is beyond the scope of this document to provide 
detailed instructions on how to connect your host to the Internet, but we 
can offer some general guidelines. 
 
First, your host must be able to receive Telnet or Secure Shell (ssh) 
connections across a network. This normally requires that the host 
machine have an ethernet adaptor and TCP/IP networking software 
configured. All Unix-based hosts should support both Telnet and ssh. NT-
based hosts may only support Telnet. 
 
Second, you will need a permanent Internet connection with a static IP 
address. You may be able to use a DSL or Cable Modem connection, or 
some other high-speed link. A static IP address is necessary, because the 
.ats file (a static file saved on your web server) contains the IP address of 
the host machine. If your host gets its IP address assigned dynamically, 
then you would need to update the .ats file each time the host’s IP address 
changes. 
 
Finally, you need to consider security. Often, a gateway or router is used 
between your Internet connection and the local area network which 
connects to your host machine. The gateway or router can be configured to 
route inbound Telnet or ssh requests to the IP address of your host on the 
local network. The outside world sees the IP address of the gateway or 
router, not the IP address of the host. This is the IP address that should be 
specified in your .ats file. The gateway may also be able to restrict inbound 
connections and only allow connections from specific addresses. 
 
AccuTerm 2000 supports Secure Shell (ssh) connections between the user's 
PC and the host. If you are concerned about privacy, use ssh instead of 
Telnet. The entire ssh session is encrypted, including login name and 
password. AccuTerm ssh is version 1 compliant, and uses triple-DES 
encryption with password authentication. 
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To use ssh, the host machine must be running an ssh server program (sshd, 
similar to telnetd). The ssh server is available for most Unix-based hosts 
(see www.openssh.org for more information). 
 
If you need to connect to an NT-based host which does not support ssh, 
consider using a small Linux machine as a gateway. The Linux gateway 
can accept inbound ssh connections, then automatically open a Telnet 
connection to the NT-based host. 
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ACCUTERM INTERNET CLIENT 
 
 

The AccuTerm 2000 Internet Edition Client component files are installed 
on the user’s computer automatically by the browser. The first time the 
user connects to a site requiring the AccuTerm Internet Client, the files are 
downloaded and installed. Subsequently, the files are only downloaded if 
newer versions of one or more files become available. 
 
The files may be downloaded from the Internet or from an intranet. When 
you create a connection, you can choose to create an Internet or intranet 
HTML link file. If you choose to create an Internet link file, the component 
files are downloaded from AccuSoft’s web site. The user must fill out an 
information form, and accept the fee-free software license agreement 
before the software is installed. The component installation has been 
optimized so that only those files which are not present on the user’s 
computer (or are out of date) are downloaded. 
 
If an intranet html file is used, the files are obtained from the atiecli2.cab 
file on the local web server. The atiecli2.cab file is not optimized for 
Internet deployment. 
 
In either case, the component files are distributed in a .cab file which 
includes a “digital certificate” identifying the source of the files as 
“Schellenbach & Assoc., Inc. dba AccuSoft Enterprises”. The browser may 
display this certificate before installing the components and allow the user 
to cancel the installation of the component files. 
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TROUBLESHOOTING 
 
 

Browser Compatibility 
AccuTerm 2000 Internet Edition only supports the Microsoft Internet 
Explorer browsers. Internet Explorer 3.0 and above are supported. Due to 
bugs in IE 3.0, the digital certificate used to authenticate the client 
software components is not recognized correctly. IE 3.02 corrects this. 
AccuSoft recommends using IE 4.0 or above. 
 
 
Unable to establish SSH connection 
If you are unable to establish an ssh connection to the host, it is usually 
caused by not having the 128 bit High Encryption Pack installed on the 
client PC. Make sure 128 bit encryption is installed by clicking Help -> 
About Internet Explorer. Check the Cipher Strength setting. 
 
 
Nailed Ports 
Because all users accessing a given web page will share a single .ats file, 
using “nailed ports” is not recommended. 
 
 
Can’t install client program from web 
Security at some organizations prevents the installation of the AccuTerm 
2000 Internet Client programs from AccuSoft's web site. This code is 
downloaded automatically by Internet Explorer using http, but some 
firewall and/or proxy server configurations seem to block this function. In 
this case, you might need to ship a Client Install CD to the customer. You 
can create a Client Install CD by copying the files in the Client Install 
folder of your program CD to the root directory of a blank CD. 
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